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1. Product Overview

1.1. What is Control Center?

Control Center is managing software that can control max 1000 units installed in remote area.
It provides functions such as real-time monitoring, search and backup of recorded image and setting. It
also supports dual monitor and can monitor max 128 channels simultaneously. So effective search can be

done : It can be done with designated motion area, and text search is also possible.

It allows user to understand and deal with various situation of each unit. Also it provides function such as

recording and searching event. If event is triggered, relevant image can be pop-up.

It is to easily control many units classified according to view set and map.

1.2. PC System Requirements

Minimum Recommended
CPU Intel Pentium 4 / 3.0GHz Core2duo E6750 or higher
Memory 1GB 2GB or higher
Video Card 128MB 512MB or higher
Resolution 1280 x 1024 (with 32bit color) or higher
HDD storage 80GB or higher
space
(0N Windows XP Professional / Window Vista Business
Others DirectX 9.0 or higher

Control Center is optimized for XP (service pack2 recommended).
In case using the video driver which is provided from Microsoft, the display in user’s screen could be
seriously flickering and its efficiency can decrease, so do not use DirectX, or establish the up-to-date

driver which is provided from the video card manufacturing company.



1.3. Installation Program
1) Run “1.x.x.x Setup.exe” file in Control Center Setup CD.

In order to install Control Center, user account on local PC should be Administrator.

© Control Center 1.2.0.4-USBKey Setup

License Agreement

Please review the license terms before installing Control Center
1.2.0,4-J5BKey,

Press Page Dawn to see the rest of the agreement.

[ >

Control Center - End User License Agreement
Capreright {(C) \WebGate Inc,
Al Rights Reserved 3

Mokice For User

This End User License Agreement (EULAY applies ko the registered version of Conkral
Center. You should carefully read the Following terms and conditions before using this
software, This ELLA is a legal agreement between vou (an individual or a single entity)
and WebGate Inc. For Control Center software, which may include assaciated CD-ROM,
printed materials, documentation, media, and Internet related on-line documentation, By
installing, copying, ar using this produck, wou agree to be bound by the kerms of this LY

If wou accept the terms of the agreement, click I Agree to continue. You must accept the
agreement to install Conkral Center 1.2.0.4-L5EKey.

I Agres ] [ Cancel

2) Click on “T Agree” button.

© Control Center 1.2.0.4-USBKey Setup

Regiztration
Please Fill the Following reqistration Fields.

{3 Trial Yersion
@' License Version

The license key should be a 40 digit sequence, i.e
1234567 8-ABCDEFGH-12345675-ABCDEFGH-12345675

License Key [

< Back, ][ Mext = ] [ Zancel

3) When registering with using USB key, it should be put in PC. Unless Key Driver is installed, the

program installs USB Key Driver automatically.



After the Driver is installed, the program moves to next page and shows license key from USB Key
automatically. If installing without USB Key, enter the supplied license key and press the “Next” button.

Trial version can be used for 30 days, if it exceeds that period, you can not run it anymore.

® Control Center 1.2.0.4-USBKey Setup

Choose Components

Choose which Features of Control Center 1.2.0.4-USEKey vou
want to install,

Check the companents you wank ta inskall and unchedk the companents wou don't want ko
install. Click Mext to continue.

Select components ko install: Basception

Playback, e e g
Zonfig z28 its descriptit
WESP SDK

File Converter
Schedule Backup
Direckts Setup

[] startup Shorkcut

Space required; 44,3MB

< Back “ Mext = ] [ Cancel

4) Choose components and press “Next” button. WESP SDK should be installed.

& Control Center 1.2.0.4-USBKey Setup

Choose Inztall Location

Choose the Folder in which toinstall Contral Center
1.2.0.4-SBKey.

Setup will install Control Center 1,2,0,4-U5BKey in the Following Folder. To install in a different
falder, click Brawse and select anather Falder. Click Install ko start the installation,

Destination Folder

I: tProgram FilesWigital Image WorldWConkral Center | Browse.. .

Space required: 44,3MB
Space available: 21.4GE

« Back J[ Install l [ Cancel

5) Select folder and press “Install” button.



1.4. Program log in

Control Center Login

User Mame |Adminishator |
Password | |
Save User Name
[] 5ave Password

[ ok ][ cencel |

Click the “OK” button after inputting ID and Password. When login becomes correct, Control Center
program will run. The default user is “Administrator” and password is “admin”. The user‘s authority to

run program is restricted respectively.



2. Control Center Monitor

2.1. Interface

[® Control Center - [Site]

Admin  Window  Help
Tool Bar1
E |E EP Ll | I H @ X ﬁl L?.’ E &% Frame Rate 30 frames/sec

| ] Resolution Auto - | Bl

Eile  View,

Unit Explorer

@ CHE

=1 DYRO_211.53.133. 196
C o Cam #l
P Cam #2
@h Cam #3
Ewecamad S
L@ TPCam #7 ; !
- DVRO_211,53,133.89
=l
e Bz
@ RAFEN
ZAER
e
@ HAES

] E Local Area Units

| site | View Set | Map

Stakus & Action I x
nit MNNA Yideo | Sensor Input | Relay Output |T|R | Alarm Mokify | Time |
M5400_aging sEvent View oy ey ey S 88 = Assthedle  2006.11.24 13:34:02
WANDWrS best = 2006.11.24 13:40:30
M105-212 T 9y ey ey 58S [ &s Schedule Z006.11.24 13:33:40 i
M103-213 E ) Yy Yy Yy 88 s [F AsSchedule 20061124 13:35:40
M103-214 o = oy 9y 8 £ 1. K. [ #s Schedule 2006.11,24 13:33:40
M103-215 E ) “y ey ey 58S [ &s schedule Z006.11.24 13:33:40
M103-216 ) Yy 9y Yy 88 s [7 AsSchedule 20061124 1340032 o

Alarm Log | Status & Action ‘

2.1.1. View area
It has unit explorer in the left part of screen, image or map in the center part of screen, event situation in

the lower part of screen. It is composed of total three view areas.
Unit Explorer

It shows unit, view set and map in tree list according to each mode. Register, edit and eliminate unit /view

set /map.
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(Table. Tree Icon)

Icon Function

< The folder that manages registered unit.

= Shows the unit which is detected and not registered in “My Units” at local network.
I User can make the lower folder and manage it if user have registered unit.
e Shows the unit which does not have HDD fails in connection.

Fe S Shows the unit which does not have HDD fails in log in.

- Shows the unit which does not have HDD succeeds in log in.

= When alarm signal comes in, it flicks for 5 seconds.

- Shows all video channels of the unit are monitoring.

=l Indicates that a unit has HDD.

i Indicates that a unit is DVrS.

e Video Channel

o Sensor

[ Relay out

o Audio out (Talk)

[ View set

H Map

il Inside folder of map (channel, sensor, relay out and talk)

Main View

It shows monitor screen and map window according to each mode.

Event View
The event history shows event which occurs from the unit registered in “My Units” at real-time. The

Status & Action shows current event situation of each unit and control relay output, audio output device.

Click B button to lead to docking of event view.

11



2.1.2. Tool bar

There are buttons on top area, so user can make use of functions easily.

(Table. Control Center Tool Bar)

Button Function

E Hides “Unit Explore”

E! Hides “Event View”

Displays “Main View” with a full screen

m Executes playback program

Executes configuration program

Q Can search stored events according to date, unit and category

Sets option menus.

Adds unit, view set and map.**

Changes information of unit, view set and map. **

Deletes unit, view set and map. **

Stores current monitoring status as view set. **

Renews information of unit tree (connection status, detected unit list, etc).

Monitors the registered unit and view set by auto switching mode.

i RS NE . RN

Turns on/off alarm pop up.

B frames/sec ~  Change frame rate.

Closes connection which is in monitoring, or closes all map windows.

Close a connection during monitoring or windows whether it is open or not.

Selects the map which will be located on the top part among many maps of map mode
Arranges maps with cascade.

Arranges maps with tile style.

Divides monitor screen by 1~64. (1, 4,9, 13, 16, 25, 36. 49. 64)

-r__j

!
|

1

Change resolution of monitor (In case of multi monitor, each menu exist).

| : EEE @R 8

Select the current monitor whether sequence switching is used or not.

Select the monitor whether alarm popup is used or not.

Confirms information of control center version.

1 [

(**This indication means only the user who has authority of setting control center is allowed to use)

12



2.2. Unit mode
It registers many units and manages them. User can easily register a unit searched by “Discover” and

showed in “Local Area Units” folder. User can understand unit connection status through icon.

2.2.1. Making/deleting a sub folder
If selecting “Add Folder” from pop up menu after clicking on “My Units” folder, the dialogue box where
user can input folder name will be indicated. When entering folder name and clicking “OK” button, new

folder will be created.

In order to delete folder, select the “Delete Folder” from pop up menu after clicking it. If there are

registered units in the folder that user wants to delete, they will be also deleted together.

2.2.2. Registering /deleting unit
If user drags and drops a unit from “Local Area Units” to “My Units” or chooses “Add Unit” from
pop up menu after clicking “My Units”, user will see registration dialogue box. Or, select “Add” menu of

tool bar. (Add menu may be disabled according to maximal number of registrable units)

Add Unit 3
(%) Static |P Address () Dynamic IP Address
IP Address MAC Address Serial Number
Address
Find
User ID admin
Password
Save Password

Registration of static IP unit

In order to register a unit by using “Add Unit” menu, input IP address and click “Find” button. At this
time user can change port number by clicking “Advanced” button if number of unit is not default 80. User
can bring server information through process of server finding. And then “OK” button will be activated.

Input user ID, password and click “OK” button.

User will see the detected units in the list by clicking on “Auto Detect” button. Select the unit that user

wants to register and input user information.

13



User will find basic information, if user drags and drops it from “Local Area Unit”. So just input user

information and click on “OK” button.

Registration of dynamic IP unit

User can manage a unit which has dynamic IP address with registration server. (About WRS registration,
please refer to 4.Configuration)

Click the “Find” button after selecting “Dynamic IP Address” radio button and inputting registration
server/serial number. When search process is done successfully, user will input user information and

register it.

Using group ID, the unit registered at Registration Server can be searched by selecting "Dynamic IP

Address" radio button, typing Registration Server, typing Group ID, and pressing "Find by Group ID".

Change of unit information
In order to change information of registered unit, select “Edit Unit” from pop up menu after selecting a

unit. Then a dialogue box will appear. Or select “Edit” menu of tool bar, user can change port number

and user information.

Deletion of unit

In order to delete registered unit, select “Delete Unit” from pop up menu. Or select . “Delete” menu of

tool bar.

2.2.3. Revising information of unit
If selecting “Refresh” from pop up menu of unit tree or clicking “Refresh” button of tool bar, information

of registered unit and detected unit list at network will be renewed.

2.2.4. Viewing image

When unit is connected, the video channel of unit in tree will be shown. User can see live image on
monitor of “Main View” after selecting certain channel. If user drags and drops channel item to monitor,
an image will be displayed at the designated location. In order to see all channels of certain unit, select an
icon of unit, then all channels will be played and screen division will be changed according to number of

channel.

14



2.3. View set mode
When registering group of channels in “View Set”, user can easily manage them. Select “View Set” tab in

“Unit Explorer”.

2.3.1. Registering / deleting view set

Quick Save View Set

User can register the current monitoring at site mode as view set. After selecting channel, click @
“Quick Save View Set” button of tool bar. Information such as current division, channel, frame rate and

resolutioin will be saved together with it.

Registration on the menu

When selecting “Add View Set” from pop up menu, the registration dialogue box is open. Or click on

“Add” menu of tool bar.

oz 10 &l e o s o

= & My Units ~
{ s

inDVrS Test - 1
1 D5412_10.10.10.2
1 DS800_10.10.10.1

1QT_4

S Test- 2
5412_10.10.10.2
1 DS800_10.10.10.1
# =1 D5800_201

=1 0T_10.10.10.3
1974

hbpark WirDVrS

=1 D5412_10.10.10.2
=1 DS800_10.10.10.1

04-10, 10.2.202-Aging
04-10,10.2.203-Aging
04-10, 10.2.204-Aging

NA10 10 T MNE_Arinn

Edit View Set
When selecting “View Set” and then “Edit View Set” from pop up menu, the dialogue box is open. Or

click on “Edit” menu of tool bar.

Delete View Set
When selecting “View Set” and then “Delete View Set” from pop up menu, the dialogue box is open. Or

click on ' “Delete” menu of tool bar.
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2.3.2. Viewing image
When selecting the registered view set or dragging and dropping it, screen is divided according to

division of view set and channel of view set is played.

AddViewSet
ol 8 1 ) g ] o

=il WinDvrs Test - 1
= & DS412_10.10.10.2

‘@n CH1

&n CH2

@n CH3

o CHA
5800_10.10.10.1
T_10.10.10.3
T_4
WrS Test - 2
5412_10.10.10.2
5800_10.10.10.1
S800_201
T_10.10.10.3

hbpark WinDVrs
5412_10.10.10.2
S800_10.10.10.1
T_10.10.10.3

peeeHeesamdons

Caneel
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2.4. Map mode

User can mange system relating to channel, audio out, relay out, and sensor by way of registering them in
the map. Select the map tab of “Unit Explorer”.
2.4.1. Map Editor

Run “Tools>Map Editor” in map mode.

% MapEditor - [map]

BF Fle View Tools Window Help

-t
DWLT.

Map Tree 2
=& My Units = Map
- B106-108 T map
1 B BANANA

=)

@ CH1

[

@ cH2
@ CH3
@ CHa
@ CHS
@ CHe
@ CHT
o CHS
@ cHe
- @ CH10
@ cH11
& cH12
@ CH13
@ CH14
@ CH1S
@ CH16
% sensorl

™|

=
|
|

23

| 1 —
=m
- E
l 22| [ | 7 25
| A%dS
% Sensoré

% Sensors Map Name map
% Sensor3
%y Sensor1n @ Ineg:
% Sensor1l s
%y Sensor12 £
%y Sensor13
% Sensorid

% sensor2

% Sensor3
% Sensors
%, Sensors

% Sensor1s

% Sensoris

8 Relsy Outputi
8 Relay Output2
2 Relay Output3
4 Relzy Outputd
8 Relay Outputs
8 Relay Outputs
8 Relay Output?
8 Relay Outputs
8 Relay outputs
8 Relay Output10 Sl 3

Ready

(Table : Map Editor Tool Bar)

Button Function

0 Add a Map

= Save map information
Unit Tree

Display available map registration unit and device, which is available unit registration at only Monitor

program.

Toolbox

In case of putting submap/maplink at a map, add this icon by Drag&Drop.

Map Tree

Display tree type to view easily map configuration with the attached device. If you select item from a map

tree, “Properties” window will display edit available item.
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Properties

Edit the item contents selected from a Map Tree.

(Table : The Icon Properties at Map Tree)

Icon Type Properties
i3 Folder None
ﬂ Map Map Name
- Channel ~ None

o Sensor None

a4 Relay None

P Audio None

Register User Icon

Register User lcon g\

Channel Relay
Marmal lcon: = FRestore I al Marmal leon: - Change... Restore: I al
Disable lcan: = Change... Restore: Disable lean u Change... Restore
Status: Status:

-On Change... Fiestore -On u Change... Restore

- Off = Change... Fiestare - Off . Change... Restore

- No Video n Change... Restore
Audio Sensor
Narmal leon: Change... FRestore ™ A Narmal leon: . Change... Restore [~ &l
Disable lcor: Change... Restore Dizable lcor - Change... Restore
Status: Status:

-On n Change... Fiestore -On n Change... Restore

- Off Change... Fiestore - Off . Change... Restore

Close

As for icon, user can register the image which he/she wants to display. JPEG, GIF and BMP can be
registered.

User can execute this function in ‘“Tools > Register User Icon’ of Map Editor Menu.

2.4.2. Registering/deleting map

Registration of map

Map Editor will be executed if user selects “Add Map” from pop up menu of map tree or just clicks on

“Add” menu of tool bar.
Edition of map

“Map Editor” will be executed if user selects “Edit Map” from pop up menu of map tree or just clicks on

“Edit” menu of tool bar.
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Deletion of map

Select “Delete Map” from pop up menu of map tree or click on . “Delete” menu of tool bar.

2.4.3. Viewing map

If user selects the map in map tree, window of map will be opened.

2.4.4. Controlling device of map
Viewing image
If user selects the channel of “Channel(s)” folder of map tree or selects channel icon of map window, live

image monitor will be popped up.

Live Yiewer

Sensor

If sensor that is registered in the map is on, the sensor of the map will start flicking.
Relay out
If relay out that is registered in the map is on, relay icon of the map will start flicking. User can make

relay out on/off by clicking on its icon of the map.

Audio out

User can transmit audio to the unit by selecting audio out.
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2.4.5. Arranging map window
User can arrange windows in cascade or E tile when user opens many map windows on screen.

Select E if wanting to place specific map window on the top part.
2.5. Monitor screen

2.5.1. Screen interface

DS500_201 CH1 Cam #1

On the top part there is caption title. It has button for unit, name of channel, PTZ, and Audio control. To

the lower part of screen it shows time and event information.

(Table. Monitor menu button)

Button Function

. Stores live image (re4 file)
g PTZ

o Audio on/off

[ ) Closes connection of monitor

2.5.2. Screen division

The number of screen division is diverse (1/4/9/13/16/25/36/49/64).
2.5.3. Full screen

When selecting “Full Screen” menuﬁ, the window of main view will be converted to the full screen.

Press Esc key if wanting conversion to the original mode.
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2.5.4. Moving screen
Drag and drop an image while pressing the left button of mouse, if wanting to exchange image of two

monitors.

2.5.5. Caption information

Select the information to see from caption item of pop up menu.

<Note>

If the user selects QCIF mode to monitor under low leveled system frame rate would be also low.

In this case uncheck “caption” on option menu and it will raise frame rate.

2.5.6. Image transmission speed

User can control an image transmission speed with Frame Rate of pop up menu.

2.5.7. Image resolution

Capkion 4
Frame Rate P
Resalution #
REC Skart
Save As

Change of resolution will be necessary to suit monitor size, if setting resolution “Auto”. The Selected

resolution will be applied regardless of monitor size, if setting specific resolution.

2.5.8. Stream

In case of monitoring the model supports Mpeg-4, it shows the selectable menu for stream as follow..

Caption

Stream v Auto

REC Start 1.MPEG,FULL 15ips, Q5
Save As 2.MIPEG,FULL, 5ips, Q5
Listen

PTZ

If it set to Auto, it shows adjusted resolution to capacity of PC and window size of monitor.
Unit serves the closest stream to the resolution required.

But, if it selects specific stream, it shows the stream as required irrelevant to window size & capacity.
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— <Note>
The below table shows the number of channel by each resolution with MPEG4 Stream which can be monitoring

from Control Center Program.

Resolution Number of Channel
QCIF 32
CIF 8
HALF 4
FULL 2

(* In case of each stream with 30ips)

In case of MPEG4 Streaming from Control Center Monitor Program, It supports up to 60ips with full size
monitoring. And it will output each picture per second In case of user request more than 3 with full resolution.

The Control Center Program will not support maximum image output (support one picture per second), if the user’s

PC has lack of performance.

2.5.9. Event

When the “MD” occurs, icon will appear. When the sensor is on,m icon will appear with sensor

number.

2.5.10. Saving image

Saving live image

Select “REC Start” from the pop up menu or click recording button ® . The recording hour is also put on
record. The maximum storage hour is 10 minutes. User can set drive to store in REC tap of the “Tools>

Options” menu.

Saving still image

User can save current image as file format of bmp or eye with “Save As". Eye file can be seen with
Microsoft Internet Explorer. User can select saving method and if automatic saving is selected, he can
select recording drive and file format for saving (If manual saving is selected, user will select above

detais when selecting “Save As”)
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2.5.11. PTZ control

WebEye-IP:110 Channel #1

Pan/Tilt control

Select PTZ menu from pop up menu or click on & button. The method of PTZ control is different
between units. In case cruciform line is seen in the center of screen, user can activate Pan and Tilt with a
mouse. When user moves it to the left/right direction from the center, user will have control of Pan. When
user moves it to the top/low direction, user will have control of Tilt. The further user moves it from the

center, the faster Pan/Tilt moves.

Control of Area Zoom In

In case user can see a dotted quadrangle, it is a mode that user may zoom specific area. Drag and drop
“Zoom In Area” with a mouse. Interface will be changed to enable the unit to execute “Area Zoom In”.
Click a mouse while pressing “Shift” key if wanting to execute normal Pan/Tilt in “Area Zoom In” mode.

Basic mode will be changed to normal control mode if selecting “Normal PTZ Mode” of pop up menu.

Zoom /Focus control
If user moves mouse to the left edge or to the right edge, user can see the window for Zoom and Focus.

The unit where user can use “Area Zoom In” has “Zoom Zero” button.

Preset moving
If preset is set, “Goto Preset” is additionally indicated in the pop up menu. When user selects specific

preset position among preset list, user can move to it.
Auxiliary control

If preset is set, “Auxiliary” is additionally indicated in the pop up menu. If user selects registered menu,

the proper action will be accomplished.
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Group mode

If user enables PTZ to operate when group mode (GM) is activated, group mode will be displayed in

upper right corner of screen.

2.5.12. Audio control
If an audio is linked to channel, “Listen” of pop-up menu or audio button will be activated. The initial

audio mode is mute. Select pop-up menu or button to listen to audio. Cancel mute mode and control audio

volume. Mixing audio from multiple channels can be possible.

2.5.13. Close all

When clicking on ﬁ button, all connected monitors will be closed. When clicking on the button of map

mode, all map windows will be also closed.

2.6. Alarm log

Events from registered units are listed up real-time in the lower part.

2.6.1. Event information

Alarm Log

o o=
Uit ‘AII j Categary Al o
Time | Site Serial ‘ Event | Message ~
2006.11.06 10:50:15 CWRD DEO240410004 ;% 11 On CH11 - dotion Detected
2006.11.06 10:50:16 DWRD DEO240410004 ﬁ 12 On CH12 - Motion Detected
200611 06 10050016 DvRO DEO240410004 ;’i 13 On CH13 - Mation Detected
200611 06 10050015 DvRO DEO240410004 ﬁ 15 On CH15 - Mation Detected
200611 06 10:50:19 (o DEO24041 0004 3 16 On - Motion Detected

<.
Alarm Log | Status & Action

The event type is indicated as an icon and event number. “On/off” and event number are also indicated.

‘Keep Visible’ button on the left upper of the screen performs as toggle and if selecting(),

it will keep selected details displayed. This means it will not be effected by new event information.

(Table. Event icon)

Button Function

* , 7 Motion detect on/off

2 Y Sensor input

. | , s ] Relay output on

L No video/ video detected
- - Text input

= Authentication Fail

e Configuration Changed

User can classify events according to unit and category.
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2.6.2. Viewing image

User can see an event image with double click of list. When Motion detect is set up, only the triggered
channel is played. However when sensor or relay is set up, all channels of the triggered unit are played
and screen is divided according to the channel number of unit.

If user selects the playing channel, monitor focus will be moving towards relevant unit and if in map

mode, window will be popping up.

2.6.3. Viewing Detailed Message
Some part is printed out as for long message. If want to see full message, click Show Message menu after

pressing right button of mouse in the message column. Then message box will appear as below.

Unit | DWRO_10.10110.201 |

Date/Time |2005 06,14 10,5505 45 |

Mezzage
Inwalid Pagzword [10.10.133. 227 Monitor; admin)
[revalid Pagzweard [10.10.133. 227 Manitar: admin]
[rvalid Pagsvard [10.10.133. 227 Manitar: admin]
| Irvvalid Password (10.10.133.2

Invalid Passward (1010133, 227 N
2.7. Status & Action
Select the “Status & Action” tap of event view.
StaEus&ActiDn l}l. X
Unit MD/Mo Yideo Sensar Inpuk Relay Output | T.../R... Alarrn Mokify Time
WPServer both 12 S S S FELEELLEE 2229929 %%%%2%% B8 L EAF Asshedle 20061106 10:50:15
Aging_MS400_200 T TETP L7 LI 7} B ﬂ & = [P s schedue 2006.11.06 09:23:24
412_19% BRERRPTERRRD Y Yy 999999y g F8 PP AsShedle 20061106 1014855
M5400 by s i ol o “y y ey 288 = Asschedle 2006.11.06 10:13:43
DR ARAARARARARAR 2299299999 %%y § 88 »EF Assthedle 20081106 10:51:11
MS400_211.53,133.232 @ @ & 9 5y 5 e e B | !| A =1 [ As Schedule 2006.11.06 10:17:38
DYRO_211.53,133.89 R PEEERRE Y Yy YLy Yy ey §F8 P e Asschedle 2006,11.06 10:51:06

Alarm .Log | Status & Action

2.7.1. Status& Action information
This tab has all the information of registered unit such as MD, No Video, sensor and user can also
accomplish orders such as relay out and audio out. As for audio out, user can transmit this order to many

units at the same time. Also present time of each unit is indicated.

25



(Table. Icon)

Button Function

7 - - Motion Detect On, Channel Enable, No Video, Channel Disable

- Sensor Input
. | , 5 , s | Relay Output Disable, Off, On
& P Talk Off, Talk On
= B E HDD status
Not Recording / No Error
Recording / No Error
Not Recording / Error
Recording / Error
[Z Az Schedule , As Schedule : alarm notification is according to schedule in the Option
W AwaysOn Always On : alarm notification is always allowed
[T Abways OFff Always Off : alarm notification is not allowed

2.7.2. Viewing image
User can monitor all channels with double click. Screen division will be changed according to the number

of channels. In map mode, “Live Viewer” window is popping up.

2.7.3. Alarm notification setting at each unit

Alarm notification can be set according to each unit in the Alarm Notify column. Three modes (Always
On / Always Off / As Schedule) mean that when alarm is triggered, the notice is always allowed / notice is
not allowed / notice is according to schedule in the option. Setting value is changed by order of Always
On / As Schedule / Always Off, when clicking. At this time alarm message setting and schedule edition

can be done in Alarm Notify tab of Tools > Options...menu.

2.8. Automatic image switching

In unit mode and view set mode user can accomplish automatic image switching at a designated period of
time. User can select all screen switching or Monitor 1 Only switching. In case of view set mode
switching will be done by each view set. Switching period can be set at Sequential Switcher of Tools>
Options. In case of Monitor 1 Only checked in the site mode, the switching will be done at only the first
monitor and current image mode will be kept at the other monitor. User can not do things such as

registration, deletion, edition of view set and unit during switching.
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2.9. Alarm pop up
User can open alarm pop up at “Alarm Popup On/Off” of tool bar menu or option configuration. The
relevant channel or unit will be monitored automatically when event such as MD, sensor is occurred. It

pops up during set time. If alarm image disappear, user will see states before alarm pops up.

2.10. Event search

All event information which is transmitted to the Control Center will be stored. User can search event log

according to unit, time, and category. User should click on “Event Search Utility” g of tool bar menu in

order to execute it.

[%] Event Search Utility

Time Unit / Categony

From [ 77112005 [~ [104839am 3] | umt [ v
To [ 77262005 | [ s37saem 3| Categoy | v

Find

Time Unit Serial Event ~
20050711 10:453:41.03  211.53.133115-B101 B20220420036 i 1 0On

2005.07.11 10:49:56.01  211.53.133.115-B101 B20220420036 & 1 0On

2005.07.11 10:54:51.82 DYRO_211.53.133.232 40304500000 * 1 0On

20050711 10:57:4710 DVRO_211.53.133.232 wid0304500000 & 1 0On
2005.071110:57:53.35 DVRO_211.53.133.232 wia0304500000 i 1 0On

2005.07.11 10:58:39.93 DVRO_211.53.133.232 /40304500000 % 1 0On

2005.07.11 11:06:17.96  DVRO_211.53.133.232 /40304500000 b3 1 0On

20050711 11:06:35.46  DVRO_211.53.133.232 wa0304500000 & 1 0On
2005.07.1111:06:41.70 DVRO_211.53.133.232 wid0304500000 E] 1 0On
2005.07.1111:08:14.594 DVRO_211.53.133.232 wd0304500000 z% 1 0On

2005.07.11 11:10:58.37  DVRO_211.53.133.232 /40304500000 % 1 0On

20050711 11:11:08.73  DVRO_211.53.133.232 wia0304500000 z% 1 0On
2005.071111:13:39.89 DVRO_211.53.133.232 wia0304500000 i 1 0On

20050711 11:18:44.77  DVRO_211.53.133.232 wd0304500000 i 1 0On
2005.07.1111:29:09.35 DYRO_211.53.133.232 /40304500000 & 1 0On

2005.07.11 11:2%17.92  DVRO_211.53.133.232 40304500000 -3 1 0On
2005.07.1111:253:28.88 DVRO_211.53.133.232 wid0304500000 E] 1 0On

20050711 11:253:4881 DVRO_211.53.133.232 wd0304500000 7 1 0On

2005.07.11 10:00:4252 QT_200 DE0350611739 % 12 On

2005.07.11 10:00:42.98 OT_200 DE0350611739 3 15 On

2005.07.11 10:00:42.98 QT_200 DE0350611739 i 11 On

2005.07.11 10:00:43.01  QT_200 DE0350611739 7 13 On

2005.07.11 06:01:32.4... DT_208 DE07140310010 ﬁ 15 On

2005.07.11 10:00:45.36  OT_200 DEO350611739 7 10 On

2005.07.11 10:00:45.38 QT_200 DE0350611739 ﬁ 11 On

2005.07.11 10:00:45.38 QT_200 DE0350611739 7 15 On

2005.07.11 10:00:45.39 QT_200 DE0350611739 P 12 On

2005.07.11 10:00:45.41  OT_200 DE0350611739 & 9 0On ~|
£ 2

[ Prirt ... ] [ Prirt Preview ] [ Save ... ]

When user inputs conditions of search and click on “Find” button, result of search will be listed up. And

playback button of unit which can be searched will be activated when a row was selected.
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2.11. Program user configuration

Select “Admin> Users and passwords” menu.

Users and Passwords fg|
Users for this software:
User Name Access Rights
]ﬁAdmlnlstlator Administratar Add User [.5—<|
i User —
gz User User Name | QK
ﬁ 3 User
Password | | [ Cancel ]
Control Center
Manitor anhy
Plyback
Corffigurati
[ 0K ] [ Cancel ] L] Corfiguration

Click on “Add” button if user wants to add user account. User can set authority relating to Control Center,
Playback and Configuration program. If user has only the authority of monitoring, user can not

accomplish setting relating to unit, view set, mapping, managing user.

2.12. Option setting

User can set option of many functions if user selects “Tools>Options” menu.

2.12.1. Caption

I Caption | Monitor- REC | Alarm Matify | Sequential Switcher | Frame Rate M_ap
I|:| Uit Mame [Select &l |

[ Charnel Mumber [Unselect All ]

Channel Hame [Fort Calar |

[ Time Bl i

Ewvent [30 |

[] Transmission Speed

[ Time Zane

| Murnber of Lagin Uszers

Select caption information which will appear in monitor view and user can set unit name, channel number,
channel name, time, event, display speed, time zone information and number of login users.

User can adjust the color and the size of font of caption information.
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2.12.2. Monitor
Caption | Moritor | REC || Alam Notify Sequentigl_Swit;her I Frame Hah_a_

Montior Viewer Mode

Caption Area b

Usze Directx

[ Apply Deirterlace

] Dan't ask login information

Color Space Y “w

Dual monitor
When user wants to use dual monitor, Control Center can support this function.

Select “Dual Monitor” of monitor tab.

e Tooks  Act

BE e

oy

Time: 1 Site Serial
20081124 044511 DVRD 21153433488 Dan0307746Z
20061124 044818 DVRD_211.53133.1%8 Dans0TaeZs

% oV 0:
37 D

When running the program, window for viewing will be popping up on the screen of second monitor.
User can view image with second monitor. Channel and unit will appear on the screen of second monitor

when user uses map mode.

View mode

User can see a full image in “Full” mode. User can see image size according to CIF resolution ratio in
“Ratio” mode. As for “Caption Area” mode, caption area is indicated on top of image and image is
displayed in the left area according to ratio. As for “Use DirectX Mode”, an image is displayed with

“Direct Draw”. The higher quality graphic card user uses the better image it can show.

Deinterlace

Deinterlace On /Off

Color space
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MPEG#4 stream of ControlCenter program can produce 120 fps at full size of YUV mode while 60fps at
full size of RGB mode.
When more than 5 YUV mode/ 3 RB mode of full size video is requested, only 1{ps is available.

<Warning>

However, function of monitoring might be limited by system function (CPU, graphic card, memory)

2.12.3. Save

Caption | Maonitor | REC | Alarm Natify | Sequential Switcher | Frame Rate | Map

REC

G Dri;fe l-;ree: 38.68 EiE v
WCCOuickPecardingSiteM ame_ChannelN ame MO D_HH_MM_S5 red

Save Image
Auto Image Filename File Format | wavelet -
|G Diive Free: 38.08 GB v

WCCImagetSiteM arme_ChanneMamesw O MM DD_HH_MM_S5 aye

Select the drive that will store moving image file with “Quick Recording”. After finishing it
“CCQuickRecording” folder will be created in the selected drive and “re4” file will also be made. Folder
name consists of Unit name channel name, and re4 file will have name for the date.

Select the drive that will store moving image for setting ‘Save as’ automatic.

Select the file fomat of recorded image (BMP, Wavelet (eye)).

“CCImage” folder will be created in the selected drive and “re4” file will also be made. Folder name

consists of Unit name_channel name, and re4 file will have name for the date.
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2.12.4. Alarm

Caption] Monitor] REC  Alarm Notify ] Sequential Switcher | Frame Hate] Map ]

Alarm Pop-up Buzzer
" on ¥ Off " on i+ Off

Duration Time 1a 3: Durakion 5 EI:

Live Monitor Blink

-
" on + Cff
¥ MO on ¥ Sensor Inpuk On flarm Log
¥ Text Input * on ™ OFf
I Fix Division
Alarm Matify Schedule. .. Sensor-Channel Mapping. ..

Alarm Pop-up

To pop-up alarm mode user should set it as 'on'.

User can select or set MD, Sensor and Text while alarm pop-up is performing. It will perform according
to selected event.

Unselected event would not perform even if alarm pop-up is set as 'on'.

Duration Time

User can see an event image during the time.

Fix Division

User can fix the division of monitor screen at alarm pop-up mode.

Buzzer

When the information is transmitted to alarm log, user will be notified by sound. User can hear buzzer
when repeated number of event satisfies designated count.

Live Monitor Blink

Decide whether to draw red outer line on the image when alarm is occurred.
Alarm Log
Decide whether to indicate event in the alarm log. Even if set as “off”, important event (Authentication

fail, defective HDD, etc) will be indicated.

Sensor Channel Mapping...
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Sensor-Channel Mapping fg
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1[5z [53]s54[ss [s6[sv |58 ]s9 [s10]s11 stz |53 [s14 [515 [ste |

CH10
CHiL
CHiz
CH13
CHi4
CHIS
CHig

RERERERERERERER R R

H_EH_EDDDDDDDEDDDD.D
.H.H.!.H.D.EIIEIIEI.EIIH.D.EIIEIID.EI.EI.EI
;H.H.!.H.D.D.EIIEIIH.EIIEI.EI.EIIEI.D.D O
:HH!HDDDDDDDDDDDDD
NEREOOO00OO00onOooooo
.H.H.!.H.D.D.EIIEIID.EIIEI.EI.EIIEI.D.D O
EH.H.!.H.EIIEIII:IIIZIID.IZIII:IIIZIIIZIIIZIIDIEI O
:!H!HDDDDDDDDDDDDD
H:Ei.!:EIIEIIEI.EIIEI.EI.EIIEI.EI.EIIEIIEI.EIIEI
.H.H.H.H.EI.EI.EI.EI.EI.EI.D.EI.EI.EI.EI.EI.EI
EH.H.!.H.D.IZIIIZIIIZIIEIII:IID.IZIIIZIID.IZIIIZIIIZI

|o/m|mle|o/ojo|ojo|joojoo&ooo
:HH!HDDDDDDDDHDDDD

[}

5
FEE®ROOO00O0OOoOoooRo
REREDODOOOOOO0OOoDoOo®ROgn

User can designate the channel which will pop up according to each sensor. If user selects the unit in the

tree, the window for mapping sensor and channel will appear in the right part of screen. The selected

channel will pop up when sensor is triggered.

<Sensor Channel Mapping Example>
1. S1 - CH1, CH2 : When S1 is triggered, CH1 and CH2 will pop up.
2. S1 —All Channel : When S1 is triggered, all channel will pop up.

Alarm Notify Schedule...

Alarm Notify Schedule

= & My Units
=-{_J WinDVrs 1] 5 6 9 12 15 18 21 24
Elr'ﬁ\“l"iﬂ|::"i"f5TESt‘'1 Hour e S e £ e i Bl S el B |
| o R Sl e e L :
: =1 DS800_10.10.10.1 famit oo I III
+-f=1 DT_10.10.10.3 Buzzer III
ol QT_4 |
i WinDvrs Test -2 famlog IIIIIIIIIIIII
E-{f] hbpark winDvrs Live Monitor Blink
E-_J edvr :
[&-{_} webeye
am SPD
@ WebEye IP: 110

Click the button to edit alarm notify schedule according to each unit as above screen. Select unit and set
notify mode On(blue), Off(gray) at each unit. Click “Apply to All Units” button to apply the edited
schedule to all units. Click “All” button to set all schedule as all mode on and click “Clear” button to set

all schedule as all mode off.
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2.12.5. Automatic image switching

Caption | Monitor | REC | Alarm Motify | Sequential Switcher | Frame Rate | Map

Duration Time [zec] 5 | 2

(] Maritar 1 Oriy

If user selects the function of image automatic switching, user can view an image as much as the
number of divided screens at unit mode and can view an image by view set at view set mode. The image

switching is done according to “duration time”.

Monitor 1 Only
If checking Monitor 1 Only and selecting automatic image switching, only Monitor 1 will perform that

function at uint mode. This function can not support view set mode and map mode..

2.12.6. Frame Rate
Captiot | Manitor | REC | Alarm Matify | Sequential Switcher | Frame Rate | Map

30 frames/sec R

User can set the frame rate of all monitor images.

2.12.7. Map

Caption | Monitor | REC | Alarm Matify | Sequential Switcher | Frame Rate | Map |

Device Mame

Dizplay Unit Marne:

If checking Display Unit Name, unit name will be displayed together with registered device name in the

map.
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3. Control Center Playback

User can search and view things such as image, audio, text which are stored in unit. To playback them

user should select “Tools>Playback” menu.

3.1. Interface

17 Playback - [DYRO_211.53.133.89] CEX
- File Mew Tools Image Window Search Help
‘HE gE QA W
AR - T : T b it Parel X
i - . —Log View 2
[[Catogty By |
Time: | Description
€| Il | &=
us View
38530
=l
| 0 |
[arlime Zone ]
| [}
Sun. on. Tue. u. Fii.  Sab
-Calendar View 130 141
2 3 14 i) 18 17 18
18 20 21 22 23 24 25
26 27 28 29 30
“ 4 Taday > »
| 12:2633 =

3.1.1. View area
Play Control View

There is a function of view control. It shows user recording status through bar.
Log View
It shows a log in designated area, also shows according to category. When user double-clicks log view, it

will pop up and close of pop up view will lead to original mode.

HDD Status View

It shows the used space and free space of HDD, also shows the stored time area.
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Channel View

Select the channel user want to playback.

Calendar View

It is possible to change search section into specific time zone.

3.1.2. Tool bar
(Table. Playback Tool Bar)

Button

Function

i

=
K

i

NpE BREGDEO
=

Opens unit or stored file

Closes connection

When there is a channel exceeding screen division which is selected, user can select one as
much as number of divided screen. At this time this button is used for moving to previous
selected screen.

When there is a channel exceeding screen division which is selected user can select one as
much as number of divided screen. At this time this button is used for moving to next
screen.

Dialogue box for controlling “Zoom In”, “Brightness”, “Contrast”.

Stores image of selected monitor.

Prints image of selected monitor.

Divides monitor screen with 1, 4, 9, 16. Can search maximum 16 channels at the same
time.

Search Text

Search image with motion after designating Motion Area

Confirms information of Control Center version.

3.2. Opening unit/backup file

First of all user must select “File> Open” menu (E). User can see the unit tree which is registered in

“My Units” by using Control Center. But user can see only the unit that is possible to search because of

having HDD among registered units. If user wants to search the unit, user must select it and click on

“OK” button. If user wants to search backup file, user must press “Open Backup File” button and select it

user want to search. When user opens unit and starts searching process, user can search it from the time of

the last day which was stored in unit. Search section is adjusted according to the hour when it is stored at

last day. (If the volume of 4 hours is stored, search section will be 6 hours)
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3.3. Search

3.3.1. Image information indication

[ 2006.02.25 08:33 47 ~ 2006.02.25 030347 | gl plw] B« 8| B | pom)|
- - = L';

The image information which is stored in each channel has different concentration line according to the
number of stored frame. (The higher the recording speed is, the deeper log color is) The red colored line
indicates event image (Motion Detection, sensor), the line having red color before and behind indicates
“Pre Alarm/Post Alarm”. The scroll bar of the lower part has different length between searching sections

on the basis of 24 hours.

3.3.2. Change of search section

l. ANCLAR =AY
tmn |
30 min i

1 hour
3 hour
& hour
v 12 hour
24 hour

When pressing button of upper right corner, the menu for changing search section will pop up. The search

section can be changed such as 10 minutes, 30 minutes, 1 hours, 3 hours, 6 hours, 12 hours and 24 hours.

3.3.3. Channel selection

The channel where the search can be done is activated. Press the button to select channel.

3.3.4. Calendar search

User can move search section to specific date in pause mode. Press the date of calendar or press ﬂ

button after inputting wanted time.

3.3.5. Log information indication & Search
User can see a log list which is within search section at log view. Log list shows only the log relevant to
the channel that is being searched and user can see it according to category. User can move to relevant

time zone with double click of log in log list.
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3.3.6. Text search

B Text Search @

Unit

From Keyword
| 2005-07-26 » || 02:20:28 : option

To * Separator is blank

| 2005-07-27 ~ || 14:41:47 A @ao Oor

[ Search I

0y | nime Description

[ 07.27 14:38:33 --- optional
-- optional
M4 Self tapping screws
Instruction manu,
12VDC SMPS v

-— optional
-1

Contents of Joystick o
Joystick controlle
Junction box
3m cable —
M4 Self tapping screl
Instruction manual -
12VDC SMPS

optional
o |

12VDC SMPS - 1

Cantents of Joystick controller box

User can search text within specific time zone.

As for DVrS, combo box where user can select unit will be
enabled. Press “Search” button after selecting search
section, keyword and filter condition. Then text will be
listed up. While search is going on, “progress” appears in
the lower part and when searching comes to an end it
shows the number of text filtered by keyword among total

texts.

User can save all the text in “txt” file format by clicking on
“Save” button, also can jump to the relevant time zone by
double clicking searched text. While searching text, user

can not do other kinds of search. (Motion Area Search,

Joystick contr 1 1
Jf;n-:tion boonx optional hour']ump’ playbaCk)
3m cable ——---
e
3.3.7. Smart search
S — B User can search an image that is
cHL |~ 050724 || 173815 B
R - = : motion-detected  within  designated
[Motion detected image only 20050726 |w || 20:17:26 :‘
o= Interval (sec) : :
% (@ The 1stof consecutive images SpQCIﬁc tlme zone.
= © 1stimage of every selected seconds
] ] As for DVrS, combo box where user
i

0%

Close

can select unit will be enabled. Press
button after selecting things such as
channel, territory, section, intervals that
user wants to search. User can search

only image that is recognized as

motion detection if user selects

“Motion detected image only” menu. (MD is set in configuration program) It will check all images if user

sets “Interval” 0. It will show an image at designated intervals if not.

The snapshot of the searched image is arrayed. Each snapshot is an image of the time when motion is

started. While search is going on the “progress” appears in the lower part of screen and when the search

comes to an end, user can find the number of the total image which is searched. User can view the image

on the right top of screen by clicking searched image. Double clicking will lead to jumping to searching
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time zone. While search is going on, user can not do any kinds of search. (Text search, hour jump,

playback)

3.3.8. Thumbnail search

¥ Thumbnail Search

LUnit

Time

|CHL

|2008-09-01 v || zz

[Loec

| Search

=13

“““‘\?" \&\\X\\\\Q (o= B

11:22:41

=

-

11:22:39 11:22:36

11:22:43 11:22:44

11:22:47 11:22:48

Previous

I~

Select channel to search, standard time
and press “Search” button. Recored images
in a second are indicated on the basis of
standard time at bottom area. Select
wanted interval from combo box to control
the interval of thumbnail time, and select
“Search” button
Based on the standard time in lower area,
it indicates recorded image every a second.
Select wanted interval from combo box to
control thumbnail time interval and select
“Search” button. It can select the interval
of time in 1 second, 1 minute, 1 hour, and
1 day.

If it selects each thumbnail through mouse,

the time of playback view at top is moved.

Through <| (Play a frame back), < (Play backward), [] (Stop), > (Play forward), (Play a frame ahead)

buttons, it can view image playback.

Select “Go to” button so as to move to present thumbnail search view of Playback program time.

Through “Smart Search” button, it shows the window for smart searching in the standard of thumbnail

search view time.

If select “Previous” button, it searches previous time image recorded than present thumbnail shown.

Select “Next” button to search next image recorded of present thumbnail.
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3.4. Playback

3.4.1. Playback button
(Table. Playback control button)

Function

Playbacks previous one image

Playbacks backward

Stops playback

Playbacks forward

Playbacks former one image

The former button playbacks whole image, the latter playbacks only event image

Designates playback speed. (0.5x, 1x, 2x, 4x, 8x, 16X, 24x, 32x, 64x, All) “All” is to be

EEEEEEE

l

e

a mode which playback all stored images. Playback speed (except “All”) is close to

real-time but its performance may be vulnerable to network condition.

B

Can decide whether it displays recording status of all channel of unit or recording status

of only selected channel.

3.4.2. Audio playback
Audio will be available when user playback forward at the speed of 1x. User can play audio of all

channels which are presently in playback. When user wants to turn off audio, tune in volume, playback

specific channel, click on L% button. When there is no stored audio source, “only” check box for

selecting specific channel is disabled.

3.4.3. Text

The dialogue box of text will be displayed if user press E button. The text transmitted from server

will be on screen while playback is going on. Double click of the text can lead user to the relevant time

area. User can save it in text file format by pressing “Save” button.
3.4.4. Time zone selection

When user open unit initially, present time zone will be selected automatically and it will show image bar,

calendar, log and the information of HDD. User can change time zone.
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3.5. Image control

3.5.1. Zoom/Brightness/Contrast control
If user selects “Image>Screen adjustment” menu, dialogue box for screen regulation will be popped up.

By dragging with mouse, user can designate the territory that user wants to magnify and view.

ses  Screen Adjustment |Z||E,E|

b

© B

26 12:00:00

el 0 o] !
. ind . can change brightness . nd . can change

contrast, and default (brightness 1000. contrast 0) can be set by clicking on each relevant button. Image

magnification can be done in a pause mode.

3.5.2. Image save

To save image of selected monitor, user must pop up dialogue box for saving it by clicking “Image>Save’

menu. User can save image with memo and caption in bitmap format.

3.5.3. Image print

User can print image of selected monitor together with memo if user selects “Image>Print” menu.

<Note>

1. Paper form of printing out is “A4”
2. Memo can be input maximum 7 lines and within 1 line maximum 45letters can be input, which

can meet paper size.
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3.6. Backup function

Backup Utiity

Backup Utiity

Charinel
* Select channel ta backup

M1 Oz Os O+ Os Os O7 Os
Oo CDw Dz s Cis Cas Cie

[CJwith audio, Caption (It takes time to backup, )

| L3

@recfrettypel O avi{compressed in 2YID) Orsciredtyps) () avi (compresssd in ¥VID)
From Channel From
[z007-11-04 || 201408 2| % Select channel to backup loo7-1004 v || 200408 5
To i [z Fa 4 s Fle F7 Fs =
|2007-11-06 || 11:20:22 s e MMz s s e [2om7108 | 112422 =
1 18 [ J19] [z 1 leel Jz3 | 124
File Split Size | 7s0 C—l Mbytes ol 13 i : o 130 3 Frame Rate }au v!
Image Resoltion | {613 v/
Total Sizedincluding all channel) : 145,95G
File Name File Name
Password Password
: T — "
| verify | | |
0% 024

Verify i |

User can execute backup utility by pressing back up button (@) of HDD status view.

'rec' & 'avi' can be selected. In case of selecting 'rec', it is shown as left figure. In case of selecting 'avi', it

is shown as right figure.

're4' backup can make all channels simultaneously, but 'avi' backup only one channel.

Backup is available per unit. Type backup range (date&time), channel, file division size, file name and

press "Start" button.

'avi' backup cannot type a password.

3.7. Backup Log function

Backup Log
From Channel
20071104 v || 20:14:05 4 *Select channel to backup
To #i Fz 3 ¥4 M5 e M7 Fla
|2un?-11-us v || 112422 ;i e 1011 A1z 213 [A14 [215 16
Category all bl - e 351 |28 a0 y
File Mame
i | i)
0% Start

Press (@) button, then Backup Log will run. This is backup function to make excel file format for

log information except for video image.

Type backup period (date & time), channel, file name and press “Start” button.
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3.8. DVrS unit search
User can search many units which are registered and stored in the DVrS if connecting to DVrS unit. The

tree for channel selection is seen on the right side of screen. Select the unit to search.

18 Playback - [WinDVrS test] EEX
Eile View Tools Image ‘Window Search Help

S5 flEQEL E

Pansl 7 x

Uit ] log |

=] M103-212
L e CHL
L oEm CHZ

3

| @R CHE
- M103-213
| oERCHL
@R CHz
| @ CHA
[ @ M103-214
L@ CHL
@R CHz
| @ cH3
[ M103-215
| @ CHL
@R CHZ
LN CH3
[ s M103-216
L@ CHL
@ CHz
| oEw CHE
- M103-218 b

Capacity 370.32G ( Fr
Frarm : 2006.11.23
To  2006.11.2413:

40% ==
TirneLine (GMT+05:00) S eaul B2
1 2 3 4
5 6 7 8 8§ 10 11
= 12 it 14 15 16 17 18
19 = 21 2 B[ B
% 2 | 23 W
H o4 Today L3
“l 15122507 =
Unit tree

User can see pop up menu when user press the right button of mouse in unit tree.

Display Recording Information

Properies
SR =N T

User can see store information in each unit by selecting “Display Recording Information”. Selection of

“Properties” will lead to pop-up window which will show unit information.
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Log
Unit = Log

it all w

Zaktegory | Al ~

Time Description

00:;43:11 CH10 Mo Video
00:43:12 CH10 Video Detected
00:53:34 CH2 Mo Video
00:53:35 CH2 Video Detected
01:03:50 CH2 Mo Video
01:03:51 CH2 Video Detected
01:15:42 CH14 Mo Video
01:16:43 (CH14 Video Detected
02:43:44 CH10 Mo Video
02:43:45 CH10 Video Detected
02:53:13 CHS Mo Video
02:53:14 CH5 Video Detected
03:24:37 CH14 Mo Video
03:24:33 CH14 Video Detected
04:09:15 CH5 No Video
04:09:16 (CHS Video Detected w

< | »

2

User can see the stored log which is within searched section up to now. User can see it according unit,

category.

Adjustment of name area
Selected channel of “Play Control View” is displayed with the format such as “channel name-unit name”.

User can adjust the size of the name with drag and drop of mouse.

CH1 - \ehEye 12
CH1 - WebEyve_1
CH2 - WiebEye_1
CH1 - WebEye_21
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3.9. Option setting

3.9.1. Caption

X

Options

[ &pply Dairterlace

kit M A Select Al
] Chaniel N
ahitiel M arme Unselect Al

Time
[ Time Zone

.__
)
e

| [ Cancel

User can decide whether information such as unit name, channel name, time, and event caption will be

displayed or not. Unit name will be displayed only if it is DVrS.

3.9.2. Adjustment of screen division
Options E|
Eap[ion. Screen |

Automatically adjust split screen mode for number of channels

[, Ok ] ’ Caticel ]

If user selects screen tab, the check box where user can decide if adjustment of screen division will be
done automatically will be on screen. Screen is automatically divided to the maximum 16 screens at each

choice.
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4. Configuration Tools

Configuration Tool enables user to efficiently manage and control all the products which have WESP in

it.

4.1. Interface

™ Configuration Tools

PME slllvenu | system setir
=l 412 [Audio & Te: Asism s ethng
= ﬁ Banana - WinDY't System Setting Syztem Info:
=1 : - Camera i
i Information Content
d LEE;TIZ'LIIU_-:U-W - Time/Date Unit D516000-10.10.10.6
=5 Lacal Area Uinits - Connectivity Model DS 16000
e 10.10.1.11 = Device Hardware Yersion 200
oo 10.1001.203 ; COM Port Firmnware Yersion 3314
= 10.10.1.221 L PTZ Serial Mumber DSRD40510034
Lo 10.10.1.274 L L Tewt MAC Address 00:30:a1:c0:12:(3
o 1010.1,226 L IP' Address il
R st Description R
@ 10.10.1.36 & User
e 10.10.1.38 _ ; IP Filtering
o 1010.1.42 LSt
s 10.10.1.48 - Miscellaneaus [ Export J [ Import ]
e 10,10,1,49 L
;o 10.10.1,50 Action Setting
@ 10,10.1.51 i
G . gl\lj;tScheduhng [ FReboot | [ FactoyDefaut | [ Change IP Address |
- =110.10.10,223 T
=1 10.10.10.224 | B Rssstion
=1 10.10,10,225 & Recording
~&10.10.10.227 - Alarm Recordin
=1 10.10010.225
o=110010010.7
coams 10,10,103.1
coams 10,10,103.10
codms 10,10,103.11
coams 10,10.103.12
coams 1001001033 K
- i 5 b
L —
- ~ J \C ~ I S—_ -
—
Site Tree Menu Configuration Page

The full screen of Configuration Tool is as above and its contents are such as site tree, menu and

configuration page.

4.1.1. Site Tree
The units which is listed in unit tree are registered in main view of Control Center and it is not possible

for user to register/delete/revise them using Configuration Tool.

The list is periodically synchronized with “My Units” of Control Center. And when user press the

“Refresh” button in lower part, all the information will be renewed rightly.

The details which user can configure will appear in menu if user clicks specific unit. System setting page

will also appear default value in configuration page.
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4.1.2. Menu
The details of menu are different according to model type of unit. Setting page relating to details will

appear in configuration page if user click menu.

4.1.3. Configuration page

As “Apply” button will be activated when user changes configuration of the page, user will just press this
button to apply new configuration.

User should press “Apply” button after changing setting of each configuration page.

If user moves to another configuration page without pressing “Apply” button, dialogue box will appear to

ask user whether new configuration will be applied.

<Note>

* For the detailed setting information of product, please refer to each manual.
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5. Schedule Backup

According to the reserved schedule, schedule backup is program to support the reserved image data at
DVR or DVrS including HDD backup at HDD, which is used only for Administrator account and unit

registration information.
Backup usually is the work which moves recorded data of HDD to the HDD of another PC.

User can designate the time at his discretion when he wants Schedule Backup to start, and it will perform

automatically according to reserved time.

Backup program should be processing in the back ground to start working. If Control Center Installer is
installed normally, Schedule Backup program will be registered automatically in the Start program of

Windows, so it will be executed at every booting of PC.

Schedule Backup program can work on only one unit at the same hour. Also only one Administrator is

allowed to work on one unit at the same hour.

Backup file is created in the specific directory of PC and it can be playback by Control Center Playback

program.

<Warning>

However, function of monitoring might be limited by system function (CPU, graphic card, memory)
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5.1. Backup setup

ol Center Pro Schedule Backup

J

Backup Status ]

[ Backup Setup

2007-11-06 Tuesday 20:36:22

|\Backup\DS1600QVY Y Y YMMDD_H, Password

= & My Units L
-I=1 D51600Q Name
=1 D5412
== D5412_2 Drestination
=1 D5412_224 |Drive +
=1 DS&00_2

® All badkup files stored on same drive

o

=1 DVRO_10.10.10.187
-i=1 DVRO_192,168.0,133
=1 DVRO_1592.168.0.251
=1 DVRO_192.168.0.3
=1 DVR0O_211.53.133.226

Available Space

Auto Deletion

Select Backup Data Range

Preservation | 5 |: Dayis)

= MDiso0L 223 Prz3sstyesuuemrsaverromny
-E=1 MDB00M_219
=1 MS400_211.53,133.228 5 e e e [ e e
=1 M3400_211,53,133.88 []Backup event only [ selctan ) [ Clearan ]
=1 M5400_Aging_231 Ch1 Chz Ch3 Ch4 Chs Ché Chv Cha
-E=1 M5400_Aging_233 che chio chid chiz chi3 chi4 chis Chig
=1 MS400_Aging_234 = S o L
e i C C Ch2 Cha Ch22 Ch23 Chi
=1 WDR-416H
Backup Timetable
0 1 2 3 4 5 6 7 8 § 10 1112PM1 2 3 4 5 & 7 8 § 10 1 12
e R O e R e Iy s A O vy
Daity Cr T T T T T T T T T o T T [ T [ T T T
Mon. CT T 0 T T T T T T T T T e T T T T T T T T
Tues. Cr T o T T T T T T T [ P T T [ T [ T T T
Wed. Cr T e T T T T T T T T o T T [ T [ T T T
Thurs. CT T 0 T T T T T T T T T el T T T T T T T T
Fri. Cr T T T T T T T T o T T [ T [ T T T
Sat. ) I ) S [ ) N ) O O |
Sun. Cr T I T T T T T T T T T o T T [ T T T T T

5.1.1. Backup file name

Backup file name is made automatically naming after date and time, its example is as follows.

YYYYMMDD HH_MM_SS

And backup file is saved in the designated folder in each unit, folder name is made as follows

\Backup\Unit name\.

At this time unit name can be seen in the left tree, and user can change it by using Control Center

Configuration Tools.

Warning

* User can not designate the name of backup file or save it in the specific folder.
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5.1.2. Password

Edit Password E|

Old Pazzword ]

I e I

EEd ittt

Retype Password

6024 | Cancel

Created backup file comes to have password, it will play a security role.

Click [Password] button to designate password in the dialogue box.

No password is designated in the initial status. So if user entering password in the first place, it is not

necessary to enter ‘Old password’, just enter password in the ‘New password’.

And retype new password to finish process.

Warning

* User should enter the password to playback backup file having password.

5.1.3. Preservation
If backup file of PC amount to exceed the HDD, it would happen to backup abnormally. So it is necessary
to delete old backup file of HDD.

It is necessary to designate preservation day for managing backup file effectively. If exceeding designated

preservation days, file would automatically be deleted.

Preservation [ s I: Drary(=)

To assign backup file preservation, [Preservation] spin button will be used shown as above, which is

minimum 1~365 days and default is 5 days.

Overdue backup file would automatically be deleted and there is 3 points of time for checking

preservation day.
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First point of time is when clicking [Apply] button after setting working time of backup, second point of
time is when backup program will be working, third is when message for advising shortage of HDD space

appears.

Warning

* Starting point of preservation days is estimated on the basis of recording time of first frame.

5.1.4. Destination
Select the drive to save recording file. If HDD is set as multiple drive, specific drive can be set as

dedicated one for recording file.

Destination

i Drwe C D E] ®All backup files stored on same drive

Drive selection can be either one or more. For example, in case of selecting C, D drive, first backup

recording is at C drive and next drive will be D drive automatically if C drive is full.

Warning

Backup file of all cameras is saved on the same drive. If designating the drive for saving backup file, all
files would be saved on the same one afterwards.

Backup drive per unit cannot be accepted.

5.1.5. Auto deletion setting
In case of not being sufficient for backup capacity at HDD, Auto Deletion Setting is to delete backup data
automatically. In case of no backup capacity, it deletes the oldest backup file from several HDD until

sufficient backup capacity is fullfill.

5.1.6. Select backup data range

Select Backup Data Range
| a0 1 2 3 4 5 & T 8
1 1

10 11 12PM 1

—u-
- b

345'3?5‘3‘2-:"‘.".2|
T o Ty T YT

S [ ] (S S ] (S S ] (s [ ] [ [ ) ] [ | |
[[]Backup event only [ sekctanl | [ Clearal |
[W]ch1 [w]chz [w]ch3 [w]chd [w]chs [w]che  [W]ch7?  [w]Cha
[#]che [#]chio  [#]chi1 [#]ch12 [#]ch13  [#|Chi4 [#]Cch1s  [#]Chis
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Designate the zone for backup among recorded data of HDD.

The time scope is based on the recording hour. Even if there is data of more than 24hours, user can

backup data as much as time scope.

Select the time zone by one hour by clicking. If wanting to unselect it, click the selected again.

User can backup the channel by selecting check box ([Chl] ... [Ch16]). Default is all channel checked.

Activated channel can be backup.

Click “Clear All” to release all channel checked.

Click “ Select All” to check all channel activated.

Also if user want to backup only event-triggered data, check the box of relevant channel and mark

[Backup Event Only] .

Warning

* Setting such as backup scope, channel and event is all applied to the schedule set on the table of backup

working time.

5.1.7. Backup Timetable

Backup Timetable
| o 1 2 3 4 & & 7 & 4
1 1

=

11121 2 3 4 & 6 7 8 8 10 11 12
11 1

Daily
hdon.

[

[

Tues. [
Wied. [
[

[

[

[

Thurs.
Fri.
Sat.
Sun.

1 [
1 [
1 1
1 [
1 1
[T I
[ 1 [
[ 1 [

User can designate time and date for backup according to each camera. And designated working time will

be displayed in the timetable.
All backup schedules are displayed in the timetable, and the camera schedule during setting is displayed

in other color. And not-designated time zone can be set for new schedule. White-bar is non-designated

time zone for schedule.
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If user locates mouse point on the bloc designated for backup, camera name will be displayed in the

format of tooltip.

Timescope can be designated by an hour. Select white block for designation by using mouse. If
unselecting

it, click it again with mouse. Backup working is repeated by a week. For example, if designating backup

time from 8pm of Monday to 12am of Monday, backup will automatically be performing from 8pm of

Monday to 12am of Monday.

User should set ‘daily’ in the backup timetable to backup the camera daily. If setting ‘daily’ and
schedule,backup will be done according to designated tiem schedule from Monday to Saturday. Therefore,
if ‘daily’ is set, backup will not be done according to day of the week. If user wants to set the schedule

according to the day of the week, it is necessary to select the day of the week and designate the time.

Backup is doned during designated schedule and even if it can not finish backup designated scope during

designated schedule, it will stop process and start next work.

5.1.8. System Tray icon

L O hE 28 1S3
&g 282

When booting PC, backup program will automatically start and relevant icon will be shown in the system

tray. While backup is done, system tray icon will show relevant information.

QOpen
Exit

2 11:53

SFEe0 za

Click the right button of mouse after locate point on the icon of system tray to view the menu.

If selecting [Open] menu, the window for status of backup progress will appear, if selecting [Exit] menu,

backup program will be finished in the background.
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Control Center Schedule Backup Login [g|

Lser Mame |a’-‘«dministratu:ur

Paszword I“”1

W Save User Name

W Save Password

ok | Cancel

Enter password to finish the program.

5.1.9. Backup file

As for backup file, relevant file is created by an hour according to each unit.

And it continuously tries to connect to the unit during designated schedule. If it is connected to the unit
successfully, backup process will be going on.

Backup process starts at the top of the hour, stops at every 59 minute of the hour.

Warning

* If backup unit of current time schedule is changed during backup, backup progress will be stopped and

be newly started.

5.2. Backup status

Control Center Schedule Backup

Backup Setup Backup Status | 2006-02-25 SéfLi'rd'ay 11:36:05
HistaryFile | .\BackupHistand20060224 csv Free Space

Unit Mame File Mame

Schedule Backup Size(MB) | Start Time

[ virD 0] Dere | W | -

2006/02/24 17:00:00 - 17:53:00  WinDW'rS - test DT[... Done K 100 12747 170001 17:20:50
20060224 16:00:00 - 16:59:00  WinDVrS - test_MW10... Done K 100 30658  16:00:01 16:43:58
20060224 14:00:00 - 14:59:00 DT [Audio] _10.10.10... Done K o 0.00 14:00:01

St Detail

User can check the status of backup progress which is doing in the background by day. Backup start time
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and status are displayed in the initial screen.

Control Center Schedule Backup - File Load... E|
B s=cop i 5]
200650224, c5v
20060225, c5v Cancel

User can search backup history at any time by clicking [Load...] button.

5.2.1. Detailed information

Schedule I Unit Flame | Backup | Drive I File hame | Progr... I Size(MEl)l Start Time | End Time Rezult
20060116 14:00:00 - 14:55:00  DS412-101010.2 Ready G 1 0.00
20060146 13:00:00 - 135300 | DSAS00D-1040406 | Done [ o [ [ [ ao0| 433311 | 1 4 | 0backu...

Detailed information for backup is displayed in the table.

The information such as ‘Schedule’, ‘Unit Name’, ‘Backup’, ‘Drive’, ‘File Name’, ‘Progress(%)’,

‘Size(MB)’, “Start Time’, ‘End Time’and ‘Result’ is displayed.

In case backup is being done, ‘Working...’ is displayed in the [Backup] menu. User can know how much

backup is done through [Progress(%)] menu and how much data is backup through [Size(MB)] menu.
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Also the status of waiting is displayed as [Ready], the status of finishing backup is displayed as [Done].

5.2.2. Detailed backup history

If wanting to get the information of backup, click [Detail] button after selecting schedule.

Control Center, Schedule Backup - Detailed Backup History

Schedule 2006/02/24 16:00:00 - 16:53:00
LInit Blame WinDwrs - test M103-07
File Mame ADetaih200602241 6_16/YinDWrS - test_WM103-07].csv
Backup | Drive | File Mame Pragres.. | Size(MB) | Ztart Time | End Titne Result #
File Open K K Backupd™inDyrs . 16:00:02
File Cloze K K Backupd™inDhWrs 100 201 .74 16:00:50 Success -
File Cpen K K BackuphiyinDhres . 16:00:53
File Cloze K K BackupiMinDyrs .. 100 55.65 16:01:07 Success
File Open K K Backup™inDhrs . 16:01:10
File Cloze K K \BackuphhyinDhrs . 100 E4.73 16:01:20 Success
File Open K K BackupiMinDyrs 16:01:23
File Cloze K K Backup™inDirs . 100 0580 16:01:29 Success
File Open K Ko Backup™inDyrs . 16:01:32
File Cloze K K Backupd™inDirs . 100 o669 160146 Success
File Cpen K K \BackuphiyinDhres . 16:01:49
File Cloze K K BackupiMinDyrs . 100 53.70 16:02:01 Success
File Open K K BackupW™inDiyrs . 16:02:05
File Cloze K K \BackuphhyinDhrs .. 100 5720 160221 Success
File Open K K BackupiMinDiyrs 16:02:24
File Cloze K K Backup™inDirs 100 12027 TE02: 44 Success
File Open K K BackupiMinDiyrs . 16:02:44
File Cloze K K Backupd™inDiVrs . 100 1265 160246 Success
File Cpen K K \BackuphiNinDhes . 16:02:50
File Cloze K K BackupiMinDyrs . 100 5.72 16:02:51 Success
File Open K K Backupd™inDiyrs . 16:02:04
File Cloze K K \BackuphhyinDhrs . 100 52.44 160301 Success
File Open K K BackupiMinDyrs 16:03:04
File Cloze K H:Backup™inDhrs 100 5244 1E:03:04 Success
File Open K K BackupiMinDyrs . 16:03:05
File Cloze K K Backupd™inDirs . 100 5244 160305 Success
File Coen K KBackunhinDhrs ... 160311 o
>

User can get the information of how many backup file is created and how big its size is (MB) if viewing

the‘Detailed Backup History’.

5.2.3. Stop backup

Click [Stop] button after selecting schedule to stop backup.

If the backup is stopped, file will be created and all information also will be recorded.

Warning

* [Stop] button is activated only when selecting ‘progress’ backup.
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#1 Control Center Series Introduction and How to Configure System
#1.1 What is Control Center?

Control Center is multi-site managing software that control max 1000 units installed in remote area.
Control Center provides functions such as real-time monitoring, search & backup of recorded image, and
setting. It also supports dual monitor and max 128 channels real-time monitoring simultaneously.
Therefore, Control Center provides designated motion area search, text search, and efficient search

function.

It allows user to understand and deal with various situation of each unit. Also it provides function such as

recording and searching event. If event is triggered, relevant image can be pop-up.

It is easily to control many units classified according to view set and map.

57



#1.2 Comparison Chart for Control Center Series

Series
Lite-W Lite-D Standard Pro Enterprise
Function
The number of
4 16 1024 1024 1024
available Unit
1/4/9/13/ 1/4/9/13/26/25 1/4/9/13/26/25 1/4/9/13/26/25
Multi Screen 1/4/9/13/16
16 36/49/64 36/49/64 36/49/64
Maximum number
1 1 2 6 4+Extension Monitor
of Monitor
Distribute
No No No No Yes
Management
Both HVRM & HB | Both HVRM & HB | Both HVRM & HB
Support Model HB Series HVRM Series
Series Series Series
Map, Device Special function (sub- | Special function (sub-
Map Function No No
Registration map, section) map, section)
Unit, Layout
No No No Yes Yes
Manage per User
Popup, relay,
Auto Action Alarm popup | Alarm popup Alarm popup Alarm popup
recording
Error Search No No No Yes Yes
Keyboard Control No No No No Yes
Price Free Free Contact us Contact us Contact us
#1.3 Key Features and Configuraion of Control Center
Support Dual Monitor
= ® Hunt WESP based DVS (Digital Video
Surveillance) solution makes multi security

function with one or two monitors
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View Set, Map

- Monitor several remote sites through the Control
Center at the central management server, which
makes convenient way to detect all devices
installed on the same network over WESP.

- Manage the unit to register max. 64 channels as a

View Set.

- Manage the registration of camera, sensor, relay-
= ' ; -5\, out, and audio out over the map

- Display event status over icon of a map and

T,

control audio out, relay-out, and etc through the

icon

Alarm Management

S

- e Rty Tew
F aatowte Zemmias
P taSdedle M0EE21Z139120
D astoes NoEQ21ERUS
F asscresm 20600151345
7 AsSchedds 00615 1R

CCLD=

E

=
=

B

® Display Camera/Sensor Input/Relay Output/Recording of a product with visible status
® Display event list as a real time, which all can be recorded and searched
® Display video image popup detected by a alarm and be enable to schedule the event by a unit whether

it will notify to a user

Playback

® Connect to recording server or open video files
saved on its PC

® Instantly playback video, audio, text, or log
history from a recording server

® Various search mode — Calendar, Time-Line, Log,
Text, and Smart Search

® Simultaneously playback max. 16ch video by time,

date, and event

® Zoom in/out or adjust brightness and contrast
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® Backup the files from a recording server

Smart Search

® Very convenient way of finding recorded
data to instantly view at a specific time
among large number of files, which save
time rather than searching Detected Motion

files

Text Search
® Efficient text search by a date & keyword, which

easily access to the corresponding time by double-

O | Time | Diescription A . .
[ 03.1308:17:20 CARDZ2 ID:02408891/ 2007,/03/13(Tuesday) clocklng 1t.
CARDZ I0:02408891] 2007/03/13( Tussday) 19:46:13
Inwalid

Function key 1
DATA : D1YZZ02406591 2007051 351 945131 A062:
[ 03.1308:17:20 CARDZ ID:02408891, Z007,03,/13(Tuesday)
CARDZ ID:02408891/ 2007/03/13( Tuesday) 19:48:15
Invalid
Funiction key 1
DATA : 01YZ2024055912007031331948151A062 <
[1 03.1308:17:21 CARDZ ID:02408891/ 2007/03/13(Tuesday)
CARDZ 10:02408891f 2007/03/13(Tuesday) 19148116
Invalid
Funckion key 1
DATA : 01YZ2202408891 2007031 331948161A062=
[ 03.1308:17:22 CARD2 ID:02408891/ 2007/03/13(Tuesday)
CARDZ 10024088911 2007/03/13(Tuesday) 19:48:17
Invalid
Funckion key 1 =
DATA : 01VE2024085912007031331 3481714062 =
[ 03.1308:17:24 CARDZ ID:02408891/ 2007/03/13(Tuesday) |
CARD?Z 002408891} 2007/03/13( Tuesday) 19:48:15
Invalid
Function key 1
DATA : 01YZZ202405591 2007051 351 94515140627
< |

v
1%

Schedule Backup

. Periodic schedule backup the video

'= Control Center Schedule Backup

Backup Setup Backup Status | 2007-03-13 Tuesday .
o wr image from DVR or DVrS.
= DYAOLI0,10,10, 198 Name |BackupDVRO_101010198W YY" | Password ‘
=1 DYRO_211,63133.192
=1 DVRO_211.53,133,198 . Destination
3. M50 Drive C T | s e on ame die ‘
I ats beistion Preservation 5 = oavs) ‘
T~ Backup evert orly.
Mch Won2 Wch3 [Wohde WOk W ChE [V ChT W Chg
W Chd ¥ Ch10 ¥ Chi1 ¥ Ch12 ¥ Ch13 v Chi4 [V ChiS W ChiB
Backup Timetable
Apply.
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#1.4 System Diagram using Control Center

WinDVrs

Internet -
or

Intranet i Lo ™
- "
VIS - g

Control Center : Management SIW

- System Management
-128ch Live Management
- Dual Monitor
- Playback
)
<Note>

Please refer to Control Center User Guide for further information.
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#2  WinDVrS Introduction and System Configuration

#2.1 What is WinDVrS?

WinDVrS is storage software based on network. User can configure system, do real-
time monitoring and search an image by using WinDVrS that saves live motion color
pictures and event information from WESP(WebGate Embedded System Protocol)-
based network camera(WebEye) or DVR helped by Control Center.

#2.2 Key Features of WinDVrS
0 Schedule Recording
0 Pre / Post Event Alarm
0 Time Synchronization through NTP
0 Remote Playback/Monitoring/Configuration
0 Easy System Management using Configuration Tool
0 Improved Searching Service
o Group User Management

0 Image re-distribution service using RDS (Option)

#2.3 Key Features of WinDVrS Series

Specification / Model WinDVrS WinDVrS Pro
Max. Recording Ch. Max. 128ch Max. 128ch
Recording Speed 5 MByte/Sec 5 MByte/Sec
Simultaneous Real-Time Max. 5 Max. 1024
Monitoring User# (5 per ch) (Total 1024)
Simultaneous Playback User# Max. 5 Max. 5
Network 100M above 100M above

Control Center (Standard / Pro / Control Center (Standard / Pro /
Remote Software
Enterprise) Enterprise)
RDS Availability X o

RDS (Image Redistrabution Service) means that it provides simultaneous image service for more than
several thousands users by ISP (Information Service Provider).

Image Redistribution Service (RDS) provided by Hunt can redistribute live imge of WebEye MPEG to
several thousands users.

Since WebEye sends image only to RDS, it maximizes its performance without losing performance. For
user point of view, it makes high quality service since it sends simultaneously high quality image to

several hundred users.
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System Diagram using WinDVrS

Win-DVrS : Recording Server S/W

- Image Recording : 128Ch, 5MB/sec
- Event Recording

- Image Distribution

Internet
or

System Diagram using RDS

Network Video Server

LY

"
b
i
)

Web Server sssssnsmnun?

L q .
% ] %
® 4 KT :
Video Data

L
. Internet .'
1
1
j 1
'

s oF p# BF jé

Network Camera

ser

TN EEEEEEEEE W

sumnjmnmnw
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<Note>

Please refer to WinDVrS User Guide for further information.
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#3 SDK Introduction for Powerful Application

#3.1 WESP (WEBGATE Embedded System Protocol) SDK

SDK (Software Development Kit) is development tool to make software without knowing its protocol.
Since SDK is programmed to use same language with software language, it is easy to use and has merit of
short-term software development period. The current SDK still has a problem to use since same products
in same manufacture are mostly used with different SDK and providing function is for a few presenting
SDK without all functions. Therefore, it should be made software per each model and had a difficulty to
unite them.

For above reason, Hunt has united each protocol for Network camera & DVR products to WESP and
WESP SDK. WESP SDK provides same usage for Network Camera or DVR, supports easy development

environment & method, and support all function for them.

#3.2 Key Features of SDK
o Provide Same Usage for HVRM & HB Series Products
o Provide Easy Development Environment and Method

o Provide All Function for HVRM & HB Series Products

#3.3 SDK Configuration
SDK consists of Monitor, Discovery, Event, Config, PTZ, and Playback.

#3.4 SDK Usage Example

Live Monitoring Example

In case of making monitoring software to provide image from Network Camera or DVR and using image from the
current software, Monitor Component can be used to view an image simply.

The below example illustrates source code for transmitting image per 30 frame with normal resolution, which upload
Monitor component at the screen, press “Live monitoring!” button, and access to use IP address, port, ID, &

password at the device.
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[visual basic 6.0]
' If clicking button, try to connect
Private Sub Command_connect_Click()
Call MonitorCtrl.Connect(“192.168.63.1”, 80, “guest”, “guest_password”)
End Sub
¢ If completing connection, request image
Private Sub MonitorCtrl AckReceived(ByVal ackCode As Long, ByVal param As Long)
If AckCode = ACK_CONNECT Then
Call MonitorCtrl.PlayVideo(1, RESOLUTION_NORMAL, 30)
End If
End Sub

<The Example of Sample Code>

i, Forml

Example of Recording

The recording function during an image monitoring at a specific point can be illustrated as the below simple code.

[visual basic 6.0]
Private Sub start_recording_Click()
Call MonitorCtrl.StartRecording("c:\quickRec\", "testRecording.re3")

End Sub
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Private Sub stop_recording_Click() MonitorCtrl.StopRecording
End Sub

Example of PTZ Control

In case of connecting to PTZ device, it is possible to make function to control PTZ using above simple code.

[visual basic 6.0]

Private Sub start_ptz_Click()
' Type channel number connected PTZ at parameter.
Call MonitorCtrl.StartPTZ(1)

End Sub

Private Sub stop_ptz_Click()
MonitorCtrl.StopPTZ
End Sub

i Forml

P e R e o
7uu4.06.16 16:18:45.631

Start PTZ Stop PTZ

Example of Component
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This example illustrates to control Sensor Input and PTZ preset using Monitor, PTZ, Event component when

occurred sensor input, which is the function to automatically move to special preset.

1. Make a connection between dome camera and sensor shown as above figure.
2. Set preset point at Dome camera (Config component can be used for setting preset)

3. Make software to move to corresponding preset according to the number of sensor input using below code.

[visual basic 6.0]

¢ If clicking start button, Event, Monitor, and PTZ ActiveX componentconnect to the device.
Private Sub Command_start_Click()

Call Event1.Connect(*“192.168.63.1”, 80, “guest”, “guest_password”, 0)

Call Monitorl.Connect(“192.168.63.17, 80, “guest”, “guest_password”)

Call PTZ1.Connect(“192.168.63.17, 80, “guest”, “guest_password”)

End Sub

¢ If clicking stop button, connection is closed.
Private Sub Command_stop_Click()

Monitorl.Disconnect
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PTZ1 Disconnect
Eventl.Disconnect

End Sub

¢ The execution function when occurred event at server.
¢ If Event categoryis “1” and EventID is “16”, Sensor Input means”on”.
¢ Then, move commend executes to move corresponding preset to same number of sensor inout.
Private Sub Eventl EventReceived(ByVal pIEvent As WESPEVENTLibCtl.IEvent)
If pIEvent.EventCategory = 1 And pIEvent.EventID = 16 Then
Call PTZ1.GotoPreset(pIEvent.NumberField)
End If

If pIEvent.EventCategory = 1 And pIEvent.EventID = 17 Then
¢ If Sensor input is “off”, there is nothing to work.
End If
End Sub

¢ If Monitor component is succeed in connection, image will be played.
Private Sub Monitorl AckReceived(ByVal AckCode As Long, ByVal Param As Long)
If AckCode = ACK_CONNECT Then
Monitor1.PlayVideo 1, 3, 15
End If
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The contents of this manual can be different in accordance with Software upgrade and design/

specification can be partly modified without prior notice to user.
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